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URSC-US v3.0 overview

Thank you for choosing this unique and powerful set of analysis
& system-development tools.

This documentation may be updated from time to time.
You can find the latest documentation update at:
http://www.metastocktools.com/URSC/URSC-US.pdf

Relative Strength Comparative (RSC) description

An RSC study normally compares a security's price with that of a 
related composite index or other data.

When the indicator is moving up, it shows that the security (the one 
displayed in the chart) is performing better than the selected index 
it is being compared against.

When the indicator is moving sideways, it shows that both are 
performing the same (i.e., rising and falling by the same 
percentages).

When the indicator moves down, it shows that the security is under-
performing the selected index (i.e., either not rising as fast or 
perhaps falling faster).

A typical use of the RSC would be to track the Comparative Relative 
Strength between say, stock XYZ and its own GICS Sector Index.
This would give an indication of how well XYZ is performing relative 
to the entire GICS sector industry.

RSC traditional problems

Traditional Relative Strength Comparisons to another data set such as 
an index, have many problems:

   RSC indicators don't plot any meaningfully consistent values,
   and thus values between different charts (specially those with
   different scales) cannot be directly compared;

   The RSC starting zero-point - which is important in determining
   the current RSC level - shifts according to the amount of data
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   available for each chart;

   RSC indices have to be manually chosen for each new chart, which
   means automatic explorations and systems based on traditional
   RSC's are not possible.

URSC solutions

All the above shortcomings (and more) are addressed by the
URSC plug-in kit:

 
• Normalized values with true % levels that are directly comparable
  to all charts;

• Adjustable common zero-starting data points, independent of
  any missing chart data;

• Automatic selection of GICS Sector Indices, to match
  each stock;

• Automatic GICS vs major market index Relative Strength Comparisons;

• Automatic display of GICS Industry numbers for current chart;

• Chart Experts can display above/below strength zones and URSC-EMA
  breakout signals;

• Complex & detailed URSC Explorations of all stocks vs major
  indices;

• URSC Explorations of all stocks vs their respective GICS sector
  indices;

• Complex Exploration filtering of any combination of selected
  GICS Industry Groups.

• Create your own favourites lists - safer, easier and more useful
  than MetaStock's volatile-storage method.

URSC basics

The URSC plot values (on the y-axis) equate to the relative strength 
% between the chart and chosen index.  These % values are absolutely 
comparable to other URSC readings thanks to the URSC common zero-
start point.

The zero reference flat line (it automatically disappears if it puts 
the URSC plot out of scale) represents the index being compared to - 
in essence, it is the index flattened out.

URSC-based strategies

Countless articles & books have been written about the use or 
Relative Strength Comparison strategies.  There is an excellent URSC 
strategy written by Jim, a full-time professional trader, available 
here:



MetaStock Tips & Tricks monthly newsletter (issues Dec 2004 ~ Feb 
2005)
http://www.metastocktips.co.nz/

Jim chooses to remain anonymous, and kindly provides the following 
summary:

For the last several years, I've made my entire living from trading.
I've developed almost all of my own systems, which I have learned to 
do by reading well over 100 trading and systems development books, 
and spending thousands of hours testing indicators, experts and 
filters. 

Here's a few things I do with the URSC code. 

1. Knowing that the RSC value of a stock is high does not indicate 
that particular stock is a good trade.  So I don't use it that way.  
For an RSC value to have trade value, it has to be taken into 
context against other setups, indicators and signals.

2. One of the most useful features of the RSC is using it as a 
moving average crossover against itself.  Some of the best trade 
signals come from the crossover.  I like to use it with my other 
indicators as a confirmation, and sometimes as an entry.  In 
addition, when I'm in a trade and the market is consolidating, an 
RSC crossover to the negative side is usually a very good early exit 
signal. 

3. I sometimes use it as a filter.  This has to be tested.  Some of 
my systems perform better if I limit the range of the RSC values.  
This is not always the case, but sometimes it is. 

4. When I find trades that are already in a trend, it's difficult to 
decide if entering the trade in the middle of the trend is a good 
idea.  The slope of both the RSC and it's moving average, as well as 
the position of the RSC line in relation to it's MA, give me a lot 
of valuable insight into whether the timing is good for entering the 
trend. 

5. When I'm trading the indexes, I use the RSC code to tell me which 
ones I should be trading and whether I should be long or short.
I run the indexes through the RSC filter and sort them.  I open a 
chart of the 3 highest ones and look at the price, volume and 
indicator position.  If they are moving up and show signs of a 
continuing trend, I can take one or all of them as long trades.  If 
the three highest RSC indexes are breaking below a 20 bar MA, I look 
at the three lowest scoring RSC indexes for possible short trades.
Sometimes the market takes a day or two to identify the trend, and 
the RSC value and my charts tell me when the transition is in 
progress.  During transitions days, I don't trade the indices.

6. When the indices indicate an up-trend, as stated in 5 above, I 
make sure all of my trades are long.  When the indices indicate a 
down-trend, I only take short trades.  You will be surprised how 
this increases the performance of a system - any system.

7. I have 20 sectors that I think represent the overall market.  I 
have set them up as a comparison to the S&P 500 index.  I have them 
on three charts, with each sector identified with a different color 
line.  I have the colors identified on a legend.  I can open the 
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charts and within a few minutes, I know how each sector is 
performing against the market. 

8. I trade the ETF sector stocks and foreign stocks using exactly 
the same procedure as I've described in step 5 above. 

9. I use the RSC method to rank mutual funds.

10. I can rank any list of stocks within a minute or two by their 
performance against any standard I choose. 

URSC-US kit v3.0 contents

1 GICS reference database

  C:\URSC folder                 - Contains 29 GICS reference data files

1 custom MetaStock dll

  Filter.dll                     - MetaStock plug-in for GICS & favs 
filtering

37 URSC-US index data-path reference indicators

US Indices data reference indicators:

  URSC-US path AMEX                 - AMEX Composite index data path
  URSC-US path DJI                  - Dow Jones 30 Industrials index data
  URSC-US path DJT                  - Dow Jones 20 Transportation index
  URSC-US path DJU                  - Dow Jones 15 Utilities index data
  URSC-US path NASDAQ               - NASDAQ index data path
  URSC-US path NASDAQ 100           - NASDAQ 100 index data path
  URSC-US path NYSE                 - NYSE Composite index data path
  URSC-US path S&P 500              - S&P 500 index data path
  URSC-US path S&P 100              - S&P 100 index data path
  URSC-US path S&P 400 MidCap       - S&P 400 MidCap index data path
  URSC-US path S&P 600 SmallCap     - S&P S&P 600 SmallCap index data path
  URSC-US path Russell 1000         - Russell 1000 index data path
  URSC-US path Russell 2000         - Russell 2000 index data path
  URSC-US path Russell 3000         - Russell 3000 index data path

US Exchange Traded Funds (ETF) data reference indicators:

  URSC-US path ETF-DIA     - ETF - Diamond Trust (DIA)
  URSC-US path ETF-IWM     - ETF - iShares Trust (IWM)
  URSC-US path ETF-MDY     - ETF - S&P MidCap 400 Depository Receipts (MDY)
  URSC-US path ETF-QQQQ    - ETF - NASDAQ 100 Tracking Stock (QQQ/QQQQ)
  URSC-US path ETF-SPY     - ETF - S&P Index Depository Receipts (SPY)

US GICS Indices data reference indicators:

  URSC-US path 10 Energy            - GICS Energy sector index 10 path



  URSC-US path 15 Materials         - GICS Materials sector index 15
  URSC-US path 20 Industrials       - GICS Industrials sector index 20
  URSC-US path 25 Consumer Discr    - GICS Consumer Discretionary 25
  URSC-US path 30 Consumer Staples  - GICS Consumer Staples sector 30
  URSC-US path 35 Health Care       - GICS Health Care sector index 35
  URSC-US path 40 Financials        - GICS Financials sector index 40
  URSC-US path 45 Inf Tech          - GICS Information Technology 45
  URSC-US path 50 Telecom           - GICS Telecommunication Services 50
  URSC-US path 55 Utilities         - GICS Utilities sector index 55

Non-specific optional data reference indicators:

  URSC path 01 generic data         - $EuroStoxx 50 example data path
  URSC path 02 generic data         - $DAX index example data path
  URSC path US Bonds                - $US Bonds data path
  URSC path Currency 01             - Currency pair data 1 path (US$-Yen)
  URSC path Currency 02             - Currency pair data 2 path (US$-$AU)
  URSC path Gold                    - $Gold data path
  URSC path Oil                     - Crude Oil data path

New: Data path verification indicator:

  URSC-US path Validation           - verifies correct index data paths

14 URSC-US Chart vs major US Indices indicators

  URSC-US Chart vs AMEX             - Chart vs AMEX index
  URSC-US Chart vs DJI              - Chart vs Dow Jones 30 Industrials
  URSC-US Chart vs DJT              - Chart vs Dow Jones 20 Transportation
  URSC-US Chart vs DJU              - Chart vs Dow Jones 15 Utilities index
  URSC-US Chart vs NASDAQ           - Chart vs NASDAQ index
  URSC-US Chart vs NASDAQ 100       - Chart vs NASDAQ 100 index
  URSC-US Chart vs NYSE             - Chart vs NYSE index
  URSC-US Chart vs S&P 500          - Chart vs S&P 500 index
  URSC-US Chart vs S&P 100          - Chart vs S&P 100 index
  URSC-US Chart vs S&P 400 MidCap   - Chart vs S&P 400 MidCap index
  URSC-US Chart vs S&P 600 SmallCap - Chart vs S&P 600 SmallCap index
  URSC-US Chart vs Russell 1000     - Chart vs Russell 1000 index
  URSC-US Chart vs Russell 2000     - Chart vs Russell 2000 index
  URSC-US Chart vs Russell 3000     - Chart vs Russell 3000 index

5 URSC-US Chart vs US ETFs indicators

  URSC-US Chart vs ETF-DIA     - Chart vs Diamonds Trust ETF
  URSC-US Chart vs ETF-IWM     - Chart vs iShares Trust ETF
  URSC-US Chart vs ETF-MDY     - Chart vs S&P 400 MidCap ETF
  URSC-US Chart vs ETF-QQQQ    - Chart vs NASDAQ 100 Tracking Stock ETF
  URSC-US Chart vs ETF-SPY     - Chart vs S&P Index Depository Receipts ETF

8 URSC-US US-specific indicators

  URSC-US Auto GICS Index            - Auto GICS Sector Idx match to chart
  URSC-US Auto GICS vs S&P 500       - Auto GICS Sector Index vs S&P 500
  URSC-US Auto Stock vs GICS Sector  - Chart vs auto GICS Sector Index 
  URSC-US GICS filter                - GICS filter binary indicator
  URSC-US GICS Industry Group Number - GICS number for current chart
  URSC-US Manual GICS vs S&P 500     - GICS Index vs S&P 500 comparison
  URSC-US Multi GICS [1] vs S&P 500  - GICS Indices 10~30 vs S&P 500
  URSC-US Multi GICS [2] vs S&P 500  - GICS Indices 35~55 vs S&P 500



13 URSC non-specific indicators

  URSC - Calendar Date default       - Choose your own reference date
  URSC - Calendar Day counter        - Accurate calendar indicator
  URSC - Chart vs 01 generic data    - Chart vs any data ($EuroStoxx 50)
  URSC - Chart vs 02 generic data    - Chart vs any data ($DAX index) 
  URSC - Chart vs Bonds              - Chart vs US Bonds
  URSC - Chart vs Chart              - Chart vs any local data
  URSC - Chart vs Currency 01        - Chart vs forex pair (US$-Yen)
  URSC - Chart vs Currency 02        - Chart vs forex pair (US$-AU$)
  URSC - Chart vs Gold               - Chart vs $Gold
  URSC - Chart vs Oil                - Chart vs Crude Oil
  URSC - Basic                       - Basic no-frills RSC, not normalized,
                                        no common zero point.
  URSC - Alternative                 - Alternative version, no common zero
                                        point, different plot.
  URSC - Liquidity Filter            - Intelligent liquidity filter, for
                                       possible use in hi-capital strategy.

New: 5 System development indicators

Please see sysdev.htm & sysdev2.htm located in the Strategies folder 
for more information on these important system-development tools.

  URSC-US Sector Trend                 - Trend filter based on GICS Sector
                                          index breakouts (automatic index
                                          matching to current security).

  URSC-US Sector Trend Profit Long %   - Sector Trend Profit Long %
                                          indicator;
                                          uses Risk-adjusted normalization.

  URSC-US Sector Trend Profit Long pa% - Annualized Long profit %pa;
                                          takes output from above 
indicator.

  URSC-US Sector Trend Profit Short %  - Sector Trend Profit Short %
                                          indicator;
                                          uses Risk-adjusted normalization.

  URSC-US Sector Trend Profit Short pa% -Annualized Short profit %pa;
                                          takes output from above indicator

4 URSC-US Expert Advisors

  URSC-US Chart vs S&P 500      - Chart vs S&P 500 URSC crossover signals
  URSC-US Stock vs GICS Sector  - Chart vs Auto GICS Sector Idx c/o signals
  URSC-US GICS Expert Commentary- Expert Commentary for multi-GICS template
  URSC-US Sector Trend          - Sector trend chart signals

7 URSC-US chart Templates

  URSC - Chart vs Gold-Oil-Bonds     - Chart vs Gold/Oil/Bonds
  URSC-US Stock vs S&P 500           - Chart vs S&P 500 Index URSC c/o
                                        signals
  URSC-US Stock vs GICS Sector       - Chart vs Auto GICS Sector c/o
                                        signals
  URSC-US1 - GICS vs S&P 500         - GICS indices 10~30 vs S&P 500 URSC



  URSC-US2 - GICS vs S&P 500         - GICS indices 35~55 vs S&P 500 URSC
  URSC-US3 - multiple GICS vs S&P 500- Same as 2 above, together in one
                                        chart
  URSC-US Sector Trend               - Sector Trend signals, Long total
                                        & annualized profit indicators.

34 URSC-US Explorations

All explorations in the 2 sections below include outputs for the following 
URSC comparison periods:

                   1 day       1 week       2 weeks
                   1 month     6 months     1 year

The exploration filters include a user-input inactivity date filter to 
exclude inactive stocks.

US Index explorations

  URSC-US Charts vs AMEX           - Charts vs AMEX index
  URSC-US Charts vs Dow Jones      - Charts vs Dow Jones 30 Industrials idx
  URSC-US Charts vs DJT            - Charts vs Dow Jones 20 Transportation
  URSC-US Charts vs DJU            - Charts vs Dow Jones 15 Utilities index
  URSC-US Charts vs NASDAQ         - Charts vs NASDAQ index
  URSC-US Charts vs NASDAQ 100     - Charts vs NASDAQ 100 index
  URSC-US Charts vs NYSE           - Charts vs NYSE index
  URSC-US Charts vs S&P 500        - Charts vs S&P 500 index
  URSC-US Charts vs S&P 100        - Charts vs S&P 100 index
  URSC-US Charts vs S&P 400 MidCap - Charts vs S&P 400 MidCap index
  URSC-US Charts vs S&P 600 SmallCap - Charts vs S&P 600 SmallCap index
  URSC-US Charts vs Russell 1000   - Charts vs Russell 1000 index
  URSC-US Charts vs Russell 2000   - Charts vs Russell 2000 index
  URSC-US Charts vs Russell 3000   - Charts vs Russell 3000 index

US Exchange Traded Funds (ETF) explorations

  URSC-US Charts vs ETF-DIA       - Charts vs Diamonds Trust ETF
  URSC-US Charts vs ETF-IWM       - Charts vs iShares Trust ETF
  URSC-US Charts vs ETF-MDY       - Charts vs S&P 400 MidCap ETF
  URSC-US Charts vs ETF-QQQQ      - Charts vs NASDAQ 100 Tracking Stock ETF
  URSC-US Charts vs ETF-SPY       - Charts vs SPY

US Stocks vs GICS Sector Index explorations

2 explorations below include separate outputs for all GICS sector indices, 
with a user-input inactivity date filter to exclude inactive stocks.

  URSC-US Stocks vs GICS 10~30      - Auto chart vs GICS indices 10~30, DJI
  URSC-US Stocks vs GICS 35~55      - Auto chart vs GICS indices 35~55,
                                       S&P500

US Market Breadth explorations

Market breadth data extracting explorations, with inactivity date filters.

  URSC-US Adv/Dec                 - Advancers/Decliners, adv/dec $ turnover
  URSC-US True 52-Week Highs      - True 52-Week Highs, sort by GICS group
  URSC-US True 52-Week Lows       - True 52-Week Lows, sort by GICS group



US GICS filtering explorations

These two explorations allow complex filtering and sorting of stocks by 
GICS Sector & GICS Industry Group criteria.

  URSC-US favourites list creation  - URSC filter/favourites list creation
  URSC-US GICS filtering            - GICS Industry Group number &
                                       filtering

Non-specific data explorations

All these explorations below include outputs for the following URSC 
comparison periods:

                   1 day       1 week       2 weeks
                   1 month     6 months     1 year

The exploration filters include a user-input inactivity date filter to 
exclude inactive stocks.

  URSC - Charts vs 01 generic data    - Charts vs any data ($EuroStoxx 50)
  URSC - Charts vs 02 generic data    - Charts vs any data ($DAX index) 
  URSC - Charts vs Bonds              - Charts vs US Bonds
  URSC - Charts vs Currency 01        - Charts vs forex pair (US$-Yen)
  URSC - Charts vs Currency 02        - Charts vs forex pair (US$-AU$)
  URSC - Charts vs Gold               - Charts vs $Gold
  URSC - Charts vs Oil                - Charts vs Crude Oil

New: System development exploration

  URSC-US Sector Trend Profit %       - Profit % Exploration based on
                                         Sector Trend signals, Long & Short
                                         and annualized.

URSC-US kit v3.0 installation instructions

Note:
   All imported URSC MetaStock Indicators, Expert Advisors
   and URSC Explorations, begin with the name "URSC" or "URSC-US".

Four easy steps:

1) Make sure MetaStock is closed (not running).

2) Run the GICSinstall.exe setup file.  This will automatically
   install the GICS reference database to C:\URSC on your PC.

   All GICS Industry Group reference data files must be in this
   location, C:\URSC\*.dat.  If this location is altered,
   then the data path to these files needs to be altered in the
   appropriate MetaStock indicator formulae.

   The installation of the URSC GICS database can also be done
   manually:



a) Create the necessary data folder for the MetaStock-URSC
   GICS reference data:  C:\URSC

b) Copy the folder contents of the attached original URSC
   data folder C:\(download folder)\URSC\URSC-US\URSC
   into your newly created C:\URSC folder.

3) Run the USpath.exe (path indicators) and USsetup.exe
   (URSC formulae) install/setup files.

   Ignore any formula reference error messages whilst importing
    formulae into MetaStock.

   Note:
    When updating to newer versions of the URSC kit, do not run the
    included USpath.exe setup file again.  Doing this will overwrite
    your existing path indicators with default data paths, which will
    then require you to copy & paste your index data path again.

4) The URSC kit needs to know the location of your MetaStock index
   data, such as for example the S&P 500 index.

   There are 36 index data-reference MetaStock indicators in the URSC
   kit, but some of them may not be necessary for your use, or you
   may not subscribe to that specific data.  You will need to edit
   the data path to each of these URSC data-reference MetaStock URSC
   indicators.

   For the S&P 500 data reference example, you will need to edit
   the contents of the "URSC-US path S&P 500" URSC indicator.

   MetaStock -> Tools -> Indicator Builder ->
   highlight "URSC-US path S&P 500" -> Edit.

   If your S&P 500 index data happens to be in the C:\MetaStock Data
   \Indices\ folder, and the symbol for your S&P 500 index is GSPC,
   then edit the following code line the "URSC-US path S&P 500" URSC
   indicator:

   Original MetaStock indicator code:
      Security("C:\ASX\Norgate\Futures\Cash\$SP",C)

   New MetaStock code:
      Security("C:\MetaStock Data\Indices\GSPC",C)

   If all of your MetaStock index data is located in the C:\MetaStock
   Data\Indices\ folder, then its just a matter of copying & pasting
   'C:\MetaStock Data\Indices\' into all URSC data reference
   indicators data path, taking care to add the correct symbol for
   each index and keep the "" quotation characters and all other code
   intact.

   When all index data path has been placed within the data path
   indicators, verify correct data paths by plotting the
  "URSC-US path Validation" indicator in a window below any chart.
   MetaStock will flag any errors found in the main data path
   indicators, making any necessary correction easier to accomplish.

   For US GICS Sector indices, input the data path and name to your
   REUTERS/Bloomberg GICS indices as per table below.



  GICS Sector                          US Index
                                  Reuters  Bloomberg
  10  Energy                       .GSPE    S5ENRS
  15  Materials                    .GSPM    S5MATR
  20  Industrials                  .GSPI    S5INDU
  25  Consumer Discretionary       .GSPD    S5COND
  30  Consumer Staples             .GSPS    S5CONS
  35  Health Care                  .GSPA    S5HLTH
  40  Financials                   .GSPF    S5FINL
  45  Information Technology       .GSPT    S5INFT
  50  Telecommunication Services   .GSPL    S5TELS
  55  Utilities                    .GSPU    S5UTIL

   If data is available, US GICS Industry Group indices may also be
   used to create additional reference/URSC indicators, as per
   instructions later in this documentation and data table below.

  GICS Industry Group                                US Index
                                                 Reuters   Bloomberg
  101  Energy                                   .GSPEN     S5ENRSX
  151  Materials                                .GSPMA     S5MATRX
  201  Capital Goods                            .GSPIC     S5CPGS
  202  Commercial Services & Supplies           .GSPCS     S5COMS
  203  Transportation                           .GSPTRN    S5TRAN
  251  Automobile & Components                  .GSPAU     S5AUCO
  252  Consumer Durables & Apparel              .GSPLP     S5CODU
  253  Consumer Services                        .GSPHR     S5HOTR
  254  Media                                    .GSPME     S5MEDA
  255  Retailing                                .GSPMS     S5RETL
  301  Food & Staples Retailing                 .GSPFD     S5FDDR
  302  Food, Beverage & Tobacco                 .GSPFBT    S5FDBT
  303  Household & Personal Products            .GSPHHPE   S5HOUS
  351  Health Care Equipment & Services         .GSPHC     S5HCES
  352  Pharmaceuticals, Biotechnology
        & Life Sciences                         .GSPPHB    S5PHRM
  401  Banks                                    .GSPBK     S5BANKX
  402  Diversified Financials                   .GSPDF     S5DIVF
  403  Insurance                                .GSPINSC   S5INSU
  404  Real Estate                              .GSPREC    S5REAL
  451  Software & Services                      .GSPIS     S5SFTW
  452  Technology Hardware & Equipment          .GSPTEHW   S5TECH
  453  Semiconductors & Semiconductor Equipment .GSPSE     S5SSEQX
  501  Telecommunication Services               .GSPTS     S5TELSX
  551  Utilities                                .GSPUL     S5UTILX

http://www.metastocktools.com/downloads/Gics.htm

Once copying & pasting "C:\MetaStock Data\Indices\" (or other path 
data) into the data-path reference indicators is complete, you are 
now ready to harness the real power of URSC Relative Strength 
analysis.

URSC-US kit v3.0 usage

To begin, open any chart in MetaStock, right-click on the chart, and 

http://www.metastocktools.com/downloads/Gics.htm


apply the URSC template of your choice.  Add indicators to suit your 
own style, and save chart setup as a new MetaStock template.

URSC indicator user-input fields

1) "Zero URSC at x calendar days back  (0 = use Date)"

This parameter allows the zero reference synchronizing point of the 
Relative Strength Comparison (RSC) to be set at a specific number of 
calendar days ago, or at a specific past date.

All URSC indicators may reference a specific date in the indicator 
"URSC - Calendar Date default".
This date (default: 1/Jan/2005) can be easily changed by the 
following process:

MetaStock -> Tools -> Indicator Builder -> select "URSC - Calendar 
Date default" indicator -> Edit -> change dd/mm/yyy dates within -> 
Ok -> Close.

2) "plot:  [1]URSC,  [2]Index-normalized plot"

This parameter allows the URSC to be plotted as a % RSC, or as a 
direct comparison which can be potted on charts.

3) "EMA signal periods  (1 = no signal)"

This parameter allows the change of the visual EMA signal.

Profit % indicator set

The URSC kit's profit % indicators have been designed as part of a 
powerful system development tool.  They correctly measure a number of 
relevant system metrics, and can be a great aid in rapid & valid 
system development.

These backtesting / system development tools are much 
faster/accurate/reliable than MetaStock's System Tester, and have 
risk-normalizing / annualizing functions which allow the direct 
comparison of different strategies with markedly contrasting risk 
profiles.  Fast & powerful system development.

Money Management vs Risk Management

"Money management" is usually a label given to the fixed percentage 
allocation of capital to each trade, such as the "place 2% of your 
portfolio capital into each trade" general rule.  If this process is 
supposed to protect a trader's capital from risk, then obviously risk 
needs to be added to the equation.

A fixed trade capital amount per trade (such as 2%) disregards the 
fact that some trades (and trading strategies) are riskier than 
others, and thus their capital needs to be reduced accordingly to 
allow for this greater risk.  Placing an equal % of capital into each 



trade and disregarding different levels of risk, is analogous to 
dividing one's wealth and placing equal amounts into each investment, 
regardless of whether it is a safe interest-bearing account or a 
risky lottery ticket.

The promise of "money management" is that it will protect a trader 
from the risk of losing his trading capital.  Not necessarily so - it 
will probably just slow down the losing process.

Money Management is *not* Risk Management

Typical Money Management strategies such as fixed trade allocation, 
do not take capital risk into consideration.

Risk Management is not possible without measuring actual risk, and 
adjusting exposed capital to it, at both trade and strategy levels.

Risk Management or correct capital allocation, is a major component 
of the risk-adjusted profit indicator set in both the URSC tool-kit 
and MACDH Divergence kit.

Individual security position size is automatically determined by the 
profit indicators, according to historical risk for the particular 
security.

Using position size tailored to individual security risk allows 100% 
of total capital allocation to any given portfolio without excessive 
risk.
More capital on safer trades, less on riskier trades.
This is the essence of risk-management.

Profit % indicators

By default, these indicators plot an instant profit % curve based on 
URSC-US Sector Trend signals (Entry & Exit rules for these indicators 
are system development examples - do not trade!), or any other 
combination of system Entry/Exit signals you wish to add (when adding 
additional entries/exits, due to a lack of available formula space it 
is best to place all code in a separate indicator, and reference its 
signals in your new profit indicator).

User inputs:

"[1]%Profit, [2]%DrwDwn, [3]PosSize%, [4]Signals"

Choice of following 5 plots:
 [1] historical rolling % profit curve;
 [2] profit Peak/Trough % drawdown curve *;
 [3] Historically risk-adjusted position % size **;
 [4] Clean Entry/Exit trade signals;
 [5] %Profit/maxRisk ratio.

* Risk is measured as the difference between profit curve peaks
  & troughs, and the largest historical difference is taken as the
  maximum potential risk.
  This is more straight-forward and realistic than using equity
  Standard Deviation, as in the traditional Sharpe ratio method of
  measuring risk for adjusting returns to risk. More on Sharpe ratio:



  http://www.miapavia.com/homes/ik2hlb/sr.htm

** This option displays the risk-adjusted position size %
  (100% = normal pos size).  More on risk normalizing below.

"Normalize %Profit beyond x% historical Drawdown"

This option allows the profit curve to be normalized to the user's 
chosen maximum historical risk of losing a trading account.
Default: 30% maximum risk.

By normalizing risk to a maximum threshold, different strategies can 
be directly compared to each other.  For example, by choosing the Buy 
& Hold option (which can have larger profits yet with much higher 
drawdowns), the divergence strategy's performance can be directly 
compared to it as a benchmark for the same period of trading.

"Entry Price:  [1]Open,  [2]Close"
Choose to enter trade on the Open or Close. Default: [2].

"Exit Price:  [1]Open,  [2]Close,  [0]Buy+Hold"
Choose to exit trade on Open or Close, or choose "0" to ignore all 
exits and plot Buy & Hold profit curve for the equivalent trading 
period. Default: [2].

For performance exploration comparisons to Buy & Hold, edit this line 
of code to change the default exit signal:

Original:
ExitPrice:=Input("Exit Price:  [1]Open,  [2]Close,  [0]
Buy+Hold",0,2,2);

Buy & Hold default:
ExitPrice:=Input("Exit Price:  [1]Open,  [2]Close,  [0]
Buy+Hold",0,2,0);

"Entry/Exit Delay periods:"
Choose to delay entry & exit by one day if using the Open for entry 
price. Default: [0].

"Total Transaction costs (Brokerage + Slippage) %:"
Add estimated brokerage & slippage % for realistic profit testing.
Default: 0.2% (use higher values for smaller trades than $10k).

Profit pa% indicators

These indicators take the output from their corresponding profit 
indicators, and plot the following:

 [1] Risk-normalized Profit %pa;
 [2] Rolling annual (from 1st Jan) risk-normalized DrawDown %;
 [3] Average trade duration in calendar Days,
      measured at each trade exit;
 [4] Average % of time (% of calendar days) spent in trades;
 [5] Trading backtest period in Years.

http://www.miapavia.com/homes/ik2hlb/sr.htm


After the first year of trading, the pa% profit indicator begins to 
annualize returns (i.e., average profit over 365 calendar days).

Whenever there are no active trade periods, the existing profit % 
divided by an increasing non-active period results in a decrease of 
the pa% average annual profit.  This plots as a down-sloping line for 
profits, and up-sloping line for losses.

For example, if the profit% indicator shows a profit of 40% over four 
years, the profit pa% will show an annualized profit of 10%pa by the 
end of that period.  For a 40% loss over the same period, the profit 
pa% will show an annualized profit of -10%pa by the end of that 
period. 

If there is a period where the stock was totally inactive (i.e., 
suspended and with no data), then the profit pa% will correctly plot 
a profit pa% step up/down when the stock returns to trading after the 
inactive period.

Profit % exploration

This exploration is an excellent system-developing tool.  It quickly 
determines median profitability for any universe of securities, and 
allows the rapid development of profitable trading strategies.

After running the exploration:

a) Click on the column A profit % header to rank results by 
profitability;

b) Select the middle profit % result, so that clicking again on the 
column header (and reversing the profitability order) does not change 
the position of the selected result.

Please see sysdev.htm & sysdev2.htm located in the Strategies folder 
for more information on this important system-development tool.

Duplicating/adapting the Profit indicators
to measure different strategies' performace.

The profit indicators are quite versatile, and can be used to test 
any trading strategy with valid entry/exit signals.

Three easy steps:

1) Copy "URSC-US Sector Trend Profit Long %" and
        "URSC-US Sector Trend Profit Long pa%" indicators;

2) Rename copied "URSC-US ...(2)" indicators to your chosen profit 
indicator names;

3) Edit/change & save the following code in your new profit 
indicator:

Original code:
{* Entry Long *}



x:=Fml("URSC-US Sector Trend");
entry:=x=1;

Change to:
{* Entry Long* }
entry:=Fml("Your Entry formula/indicator");

Original code:
{* Exit Long *}
exit:=x=0;

Change to:
{* Exit Long *}
exit:=Fml("Your Exit formula/indicator");

Original risk-based entry position size code:
{* Variable Trade Size % formula }
VarSize:=0;

Change to:
{* Variable Trade Size % formula }
VarSize:=Fml("Your Position Sizing formula");

Or, if no Position Sizing formula available:
{* Variable Trade Size % formula }
VarSize:=0;
(All original position size will now be a fixed 100%)

Actual example

Let's take an actual test example - a variation of the Darvas system.

=======================
Darvas Box - Buy & Sell
=======================
---8<-----------------------------------

{ Darvas Box - Buy & Sell v1.0

 ©Copyright 2006 Jose Silva.
  For personal use only.
  http://www.metastocktools.com }

{ User input }
pds:=Input("Lookback periods",2,2600,100);

{ Variables }
h3:=Ref(H,-3);
l3:=Ref(L,-3);
init:=Cum(IsDefined(Ref(HHV(H,pds),-4)))=1;

{ Darvas High }
DvHi:=ValueWhen(1,init OR
 h3>=Ref(HHV(H,pds),-4) AND h3>HHV(H,3),h3);

{ New Darvas High }
NuDvHi:=Dvhi<>Ref(DvHi,-1);

{ New Darvas Low }
NuDvLo:=l3<LLV(L,3) AND DvHi>HHV(H,3);
NuDvLo:=NuDvLo AND Ref(NuDvLo,-1)<1

http://www.metastocktools.com


 AND Cum(NuDvHi)>0;

{ Darvas Low }
DvLo:=ValueWhen(1,NuDvLo,l3);

{ Darvas Box End }
DvEnd:=
 BarsSince(NuDvHi)<BarsSince(Ref(NuDvLo,-1));
DvEnd:=(DvEnd AND NuDvLo)
 OR Cum(IsDefined(DvEnd))=1;

{ Darvas Box High }
DvBoxHi:=ValueWhen(1,DvEnd,DvHi);

{ Darvas Box Low }
DvBoxLo:=ValueWhen(1,DvEnd,DvLo);

{ Darvas Possible Sell }
DvPosSell:=L<DvBoxLo AND Alert(L<DvBoxLo=0,2);

{ Darvas Sell }
exit:=BarsSince(DvEnd)<BarsSince(DvPosSell);
exit:=exit=0 AND Alert(exit,2)
 OR Cum(IsDefined(exit))=1;

{ Darvas Buy }
{ Classic Darvas: change next line to H>DvBoxHi} entry:=C>DvBoxHi
 AND BarsSince(DvEnd)<BarsSince(exit);

{ Clean signals }
init:=Cum(IsDefined(entry+exit))=1;
bin:=ValueWhen(1,entry-exit<>0 OR init,entry);
long:=bin*(Alert(bin=0,2) OR init);
short:=(bin=0)*(Alert(bin,2) OR init);

{ Plot in own window }
long-short

---8<-----------------------------------

1) Copy & Paste above "Darvas Box - Buy & Sell" indicator into 
MetaStock's Indicator Builder.

2) Copy & rename the "URSC-US Sector Trend Profit Long %" & "URSC-US 
Sector Trend Profit Long pa%" to "Darvas Signals Profit Long %" & 
"Darvas Signals Profit Long pa%".

3) In the new "Darvas Signals Profit Long %" indicator,

Change original code line:
{* Entry Long *}
x:=Fml("URSC-US Sector Trend");

For:
{* Entry Long *}
x:=Fml("Darvas Box - Buy & Sell");

4) In the new "Darvas Signals Profit Long pa%" indicator,

Change original code lines:



{ Reference Profit Long & trade flag }
profit:=Fml("URSC-US Sector Trend Profit Long %");
flag:=FmlVar("URSC-US Sector Trend Profit Long %","FLAG");

For:
{ Reference Profit Long & trade flag }
profit:=Fml("Darvas Signals Profit Long %");
flag:=FmlVar("Darvas Signals Profit Long %","FLAG");

5) New exploration:

Column A: %pa
Fml("Darvas Signals Profit Long pa%")

Filter
colA<>0

6) Buy & Hold testing for the same period is done by changing 
original default output in "Darvas Signals Profit Long %" indicator 
code:

Original (exit on Close):
ExitPrice:=Input("Exit Price:  [1]Open,  [2]Close,  [0]
Buy+Hold",0,2,2);

To Buy & Hold (no exit):
ExitPrice:=Input("Exit Price:  [1]Open,  [2]Close,  [0]
Buy+Hold",0,2,0);

Actual testing was done on 485 securities in the ASX's All 
Ordinaries, backtested over a median 6.25 years of EOD data, mid-Feb 
2006.

Normally, survivorship bias would present a major problem when 
backtesting a current list of surviving securities, but since we'll 
also be testing a risk-normalized/annualized Buy&Hold strategy for 
the same period as a benchmark, any bias can be easily measured and 
accounted for.

Entry & Exit was on the Close of the signal day, 0.2% was used as a 
total brokerage/slippage to mirror lower transaction expenses in the 
US.

Risk was normalized to a maximum 30% historical drawdown, using 
backtesting methodology as explained in the Trading System 
Development Tolls webpage (available from the local strategies folder 
or http://www.metastocktools.com/URSC/sysdev.htm ).

Results
=======
Median (risk-normalized) net profit over the last 6 years:

Buy & Hold:  3.0%pa profit
Darvas:      1.6%pa profit

Summary
=======
No doubt a better exit may improve the Darvas system's performance, 
but for the time being, it under-performs a risk-normalized Buy & 

http://www.metastocktools.com/URSC/sysdev.htm


Hold strategy (for the same period) by 1.4%pa.

In other words, taking out market biases, the current Darvas system's 
annual net profit is -1.4%pa.

URSC templates explained

URSC - Chart vs Gold-Oil-Bonds

Setup:
Price (chart)
URSC - Chart vs Gold (yellow)
URSC - Chart vs Oil (red)
URSC - Chart vs Bonds (green)

This template looks at the chart vs three major market indicators: 
Gold, Oil and US Bonds.

URSC-US Stock vs GICS Sector

Setup:
URSC-US GICS Industry Group Number (yellow)
Price chart with "URSC-US Stock vs GICS Sector" Expert Advisor
URSC-US Auto Stock vs GICS Sector (yellow)

This template looks at the chart vs its corresponding GICS Sector 
Index.
The Expert Advisor arrow signals are basic crossovers of the "URSC-US 
Auto Stock vs GICS Sector" indicator and it's own 63-period EMA 
signal line.

URSC-US Stock vs S&P 500

Setup:
URSC-US GICS Industry Group Number (yellow)
Price chart with "URSC-US Chart vs S&P 500" Expert Advisor
URSC-US Chart vs S&P 500 (yellow)

This template looks at the chart vs the S&P 500 Index.
The Expert Advisor arrow signals are basic crossovers of the "URSC-US 
Chart vs S&P 500" indicator and it's own 63-period EMA signal line.

This template is the most basic URSC setup, and can easily be copied 
and adapted to chart comparisons vs any other index (see "Modifying 
URSC indicators/explorations" below).

URSC-US1 - GICS vs S&P 500

Setup:
"URSC-US Manual GICS vs S&P 500" indicators x5

This template is a visual representation of the "URSC-US Stocks vs 
GICS 10~30" Exploration.  It plots each of the first five of ten GICS 



indices vs the S&P 500.
In other words, it ranks each GICS sector's performance against the 
S&P 500.

MetaStock often loses track of parameters chosen for multiple plots 
of the same indicator, so if all five indicators in this template are 
displaying identical curves, do the following:

1) Double-click on the 1st (red) indicator, and choose GICS Sector 
Index 10;
2) Double-click on the 2nd (orange) indicator, and choose GICS Sector 
Index 15;
3) Double-click on the 3rd (pink) indicator, and choose GICS Sector 
Index 20;
4) Double-click on the 4th (gold) indicator, and choose GICS Sector 
Index 25;
5) Double-click on the 5th (dark yellow) indicator, and choose GICS 
Sector Index 30.

6) Go to File, Save As..., Save as Type: Template, double-click 
"URSC-US1 - GICS vs S&P 500.mwt" template and save (overwrite).

URSC-US2 - GICS vs S&P 500

Setup:
"URSC-US Manual GICS vs S&P 500" indicators x5

This template is a visual representation of the "URSC-US Stocks vs 
GICS 35~55" Exploration.  It plots each of the last five of ten GICS 
indices vs the S&P 500.
In other words, it ranks each GICS sector's performance against the 
S&P 500.

MetaStock often loses track of parameters chosen for multiple plots 
of the same indicator, so if all five indicators in this template are 
displaying identical curves, do the following:

1) Double-click on the 1st (bright green) indicator, and choose GICS 
Sector Index 35;
2) Double-click on the 2nd (teal) indicator, and choose GICS Sector 
Index 40;
3) Double-click on the 3rd (turquoise) indicator, and choose GICS 
Sector Index 45;
4) Double-click on the 4th (blue-gray) indicator, and choose GICS 
Sector Index 50;
5) Double-click on the 5th (blue) indicator, and choose GICS Sector 
Index 55.

6) Go to File, Save As..., Save as Type: Template, double-click 
"URSC-US2 - GICS vs S&P 500.mwt" template and save (overwrite).

URSC-US3 - multiple GICS vs S&P 500

Setup:
URSC-US Multi GICS [1] vs S&P 500
URSC-US Multi GICS [2] vs S&P 500

This template is similar to the two above, but visually compares all 
GICS Sector Indices (vs S&P 500) directly against each other on the 
same window.



Each colored plot represents a GICS sector's URSC:

Red: 10 - Energy index
Orange: 15 - Materials index
Pink: 20 - Industrials index
Gold: 25 - Consumer Discretionary index
Dark Yellow: 30 - Consumer Staples index

Bright Green: 35 - Health Care index
Teal: 40 - Financials index
Turquoise: 45 - Information Technology index
Blue-Gray: 50 - Telecommunication index
Blue: 55 - Utilities index

Clicking on View -> Expert Commentary will produce a handy 
information window with all the index color descriptions, as well as 
their corresponding URSC values for the selected period on the chart.
 

Notes

Modifying URSC indicators/explorations
Allowing comparisons to other markets

"How do I create a URSC indicator/exploration set that compares my 
charts to a different set of data, for example, the Hang Seng index?"

5 easy steps for a complete set of new URSC tools:

#1 - new data path indicator

Using MetaStock -> Tools -> Indicator Builder:

a) Make a copy of "URSC path 01 generic data" indicator.

b) Rename this new indicator
   from "URSC path 01 generic data(2)"
   to "URSC path Hang Seng".

c) Edit code data path in last line of the new indicator,
   to point data reference to your Hang Seng index data path.
   i.e.:

Change:
   Security("C:\ASX\Norgate\Futures\Cash\$SX",C)
To:
   Security("C:\MetaStock Data\Indices\Cash\$HS",C)

#2 - new URSC indicator

Using MetaStock -> Tools -> Indicator Builder:

a) Make a copy of "URSC - Chart vs 01 generic data" indicator.

b) Rename this new indicator



   from "URSC - Chart vs 01 generic data(2)"
   to "URSC - Chart vs Hang Seng".

c) Edit code data path within the new indicator (11th code line
   down), to point data reference to your new Hang Seng data path
   indicator. i.e.:

Change:
   Idx:=Fml("URSC path 01 generic data");
To:
   Idx:=Fml("URSC path Hang Seng");

#3 - new URSC exploration

Using MetaStock -> Tools -> The Explorer:

a) Make a copy of "URSC - Charts vs 01 generic data" exploration.

b) Rename this new exploration
   from "URSC - Charts vs 01 generic data"
   to "URSC - Charts vs Hang Seng".

c) Edit code data path within each column of the new exploration
  (1st line of code), to point data reference to your new Hang Seng
   data path indicator. i.e.:

Change:
   Idx:=Fml("URSC path 01 generic data");
To:
   Idx:=Fml("URSC path Hang Seng");

#4 - new URSC chart Expert

Using MetaStock -> Tools -> Expert Advisor:

a) Make a copy of "URSC-US Chart vs S&P 500" expert advisor.

b) Rename this new expert advisor to "URSC - Charts vs Hang Seng".

c) Change each formula reference
   from "URSC-US Chart vs S&P 500"
   to "URSC - Charts vs Hang Seng" in:

   2 locations in the Trends tab;
   2 locations in the Highlights tab;
   2 locations in the Symbols tab;
   2 locations in the Alerts tab;

#5 - new URSC template

a) Open a new clean chart.

b) Attach new "URSC - Charts vs Hang Seng" expert advisor.

c) Drop the "URSC - Chart vs Hang Seng" indicator on
   to its own window below the price chart.

d) Go to File -> Save As... -> Save as type: Template



   -> "URSC Chart vs Hang Seng".

Using the five simple steps above, a complete set of URSC 
indicators/explorations may be created for any market in the world.

Chart vs any other local data URSC

Relative strength between securities can be compared to each other in 
two different ways, directly and indirectly.
The "URSC Chart vs Security" indicator compares the current chart to 
a (hard-coded) selected security using the direct method.

For an example using (ASX stocks) BHP vs TLS, open a BHP chart and 
edit this code line in indicator "URSC Chart vs Security":

{ Input path to selected security (TLS example) }
chart2:=Security("TLS",C);

Direct comparison

As at 13/09/2004, stock ABC is +9.9% above XYZ for the year, when 
compared directly to each other.

Indirect comparison

The current 1-year relative strength for ABC vs its main index is
+2%.
The current 1-year relative strength for XYZ vs its main index is
-1.26%.  The difference between these two securities is +3.26% in 
ABC's favour, when both are compared to their respective indices.

GICS reference data updates

To update the GICS Industry Group reference data files in C:\URSC\
use any text editor (Notepad or Wordpad) to add/remove new symbols
as their GICS Group classifications change.

US GICS Industry Group constituent lists here:
http://jcsb.slu.edu/faculty/betkerbl/463/gics.html

S&P 500 index constituent list here:
http://www2.standardandpoors.com/servlet/Satellite?
pagename=sp/Page/IndicesConstituentsPg&b=4&r=1&l=EN&s=6&ig=51&i=56
&si=null&d=null&xcd=500

S&P's GICS webpage:
http://www2.standardandpoors.com/NASApp/cs/ContentServer?
pagename=sp/Page/IndicesGICSPg&r=1&l=EN&b=4&f=1

Personal Favourites portfolio creation

http://jcsb.slu.edu/faculty/betkerbl/463/gics.html
http://www2.standardandpoors.com/servlet/Satellite
http://www2.standardandpoors.com/NASApp/cs/ContentServer


How to isolate your own personal stock portfolios (favourites lists),
for system testing and exploration purposes:

1) Using any text editor such as NotePad, place your own list of
   symbols/tickers/codes in the text file named "Favs-01.dat",
   located in the C:\URSC folder.
   You can add an unlimited number of code symbols to Favs-01.dat

   Note: the lookup data file must contain the exact matching symbols
   without any leading or trailing spaces, or any other invisible
   formatting characters such as tabs.

   e.g.:

Favs-01.dat
===========
---8<----------------------
* Personal basket of stocks - insert your own codes below *
* 500 codes in S&P 500 index as at close of 27 January 2006 *
A
AA
AAPL
ABC
...
...
YHOO
YUM
ZION
ZMH
---8<----------------------

2) Make sure Favs-01.dat remains in the C:\URSC folder;

3) Use in explorations, system tests, indicators, etc,
   to filter out any stock not in your list,
   by enabling this line of code:

   { *personal favourites stock portfolio* }
   ExtFml("Filter.Symbol","C:\URSC\Favs-01.dat");

   All formulae with this code activated, will now exclusively
   process only stock data in your portfolio list as above.

4) Further favourites lists can also be created.
   The files may be named any name except existing data files names.

   e.g.:
   Favs02:=ExtFml("Filter.Symbol","C:\URSC\Favs-02.dat");
   Favs03:=ExtFml("Filter.Symbol","C:\URSC\Favs-03.dat");

   Warning:
   Some word processors attempt to save text data files with
   an *.txt file extension, such as Favs-01.dat.txt!
   Files with a *.txt extension cannot be found by
   the URSC Filter.dll if a *.dat file is requested.

Limitations



Due to some MetaStock data access "features", all URSC comparisons
are backwards-restricted to the index data file with the least
amount of data.

This means that if your indices data begins on 03/04/2000, indicators
and explorations will only begin the earliest URSC comparison from 
03/04/2000.

Q/A, problems

Unusual/inconsistent errors

MetaStock is renown for poor memory management.
Possible out-of-memory errors can occasionally manifest themselves as 
an unusual high count in exploration rejections, or an unusually 
smooth/jagged indicator plot.

If this occurs, try shutting down MetaStock and restarting it again.
If the problem persists, try re-booting your PC before contacting the 
author at the email address below.

No values displayed

If a URSC chart vs GICS indicator plots only zero values, that 
particular stock symbol is not in any of the URSC folder GICS 
reference databases.  Either the GICS reference database has not been 
updated,
or that particular stock is now defunct.

I seem to get identical exploration results for all lookback 
periods (1 day % to 1 year%) in all the URSC exploration 
columns.

By default, MetaStock loads the minimum required records for each new 
exploration.  Make sure that your exploration options are set to at 
least "Load 1000 Records", and not "Load Minimum Records".

MetaStock -> Tools -> The Explorer -> Options -> tick "Load 1000 
Records" -> Ok.

In the "URSC-US multiple GICS vs S&P500" template, I see 10 
colored lines representing each market sector's URSC.
Is there a way of adding a legend to the chart defining each 
of the URSC 10 plots?

Unfortunately there is no automatic way for MetaStock to label each 
of the 10 chart plots.  However, by clicking on "View" and then 
"Expert Commentary", all 10 URSC values may be viewed there together 
with their matched colored GICS Index names, as shown here:

   http://www.metastocktools.com/URSC/URSC-7.png

http://www.metastocktools.com/URSC/URSC-7.png


I've just tried the "URSC-US1 - GICS vs S&P 500.mwt" template.
It seems all five windows display identical values - why is this?

On URSC kit import, sometimes MetaStock resets all stored values to 
indicator default values in some templates.

To rectify this, double-click on the template's first indicator
(red line), and in "choose GICS Sector Index (10~55)", set this
option to "10".

Click on the 2nd indicator, and set the same option to "15", and so 
on:
3rd - "20"
4th - "25"
5th - "30"

Then go to File -> Saves As -> Save as type Template (*mwt) ->
overwrite existing "URSC-US1 - GICS vs S&P 500.mwt" template and 
save.

You may need to do the same for the "URSC-US2 - GICS vs S&P 500.mwt"
template (apply 35~55 values).

The URSC Expert commentary values will match the indicator values
after this.

Can you explain more on the date filter in the exploration?

When a MetaStock Exploration is run, it explores every stock 
available in that data folder(s).  Some of those stocks may be 
suspended, others may even be delisted, yet the exploration will keep 
considering those dead stocks as if they are still trading today.  
For example, if a stock last traded in 1996, and its data is still 
available, a normal MetaStock exploration would consider it as still 
trading today.

The date filter in the URSC exploration filters force the exploration 
to ignore any stocks that have not traded since the date in the 
filter, so that only active/trading stocks are searched.  Without 
this filter, the exploration may come up with the same dead stocks 
over and over again.

Would you please further explain the nature of the shifting 
plot of the URSC?  Can this be a problem?

Relative Strength Comparisons (RSC) need a common starting point 
(zero point), from where they can begin its strength comparison 
between two data sets.

As default (and this is adjustable), the URSC kit begins its RSC from
365 calendar days (exactly one year) back.

This means that if today is the 9th of May 2005, it begins its 
strength comparison from the 9th of May 2004 (or nearest trade date). 
At this point, both data sets are set to zero % RSC.



Tomorrow, on the 10th of May 2005, the URSC will begin its comparison
from a day later, the 10th of May 2004.  As the zero-start point has
now shifted forward by one day, this creates a slight "shifting" of
the URSC plot (values).  Although this shifting may be considered 
dynamic, it is not hindsight-based such as for example, with the 
ZigZag plot.

I personally do not see the URSC's floating zero start as a problem.
However, the zero-start point can be locked to a specific date in the 
URSC kit (e.g. 01/01/2004), and the dynamic nature of the URSC would
then become static - i.e. no more shifting.

To lock the URSC zero point to a specific past date, choose "0" 
lookback days in the "Zero URSC at x calendar days back  (0 = use 
Date)" URSC indicator parameters.
The "URSC - Calendar Date default" indicator holds the default date 
data when "0" lookback days are chosen in the URSC indicators.
This date (default: 1/Jan/2005) can be easily changed by the 
following process:

MetaStock -> Tools -> Indicator Builder -> select "URSC - Calendar 
Date default" indicator -> Edit -> change to new dd/mm/yyy date 
within -> Ok -> Close.

Is there more information on the Filter.dll?

ExtFml( "Filter.Symbol", "Path & Filename")

The Filter.dll was developed specifically for the URSC kit.  It is 
basically a very handy symbol-to-database matching tool that can be 
used as a security filter.  For a working example, see the "URSC 
favourites list creation" exploration.

The filter.dll simply looks for a match between the current chart's 
symbol, and any identical symbol found in the specified data 
path/file.
It will plot a "1" (true) signal if it finds a symbol match, and "0" 
(false) if it fails to find a match on the specified list.

Example:

{ ASX 500 (All Ords) liquidity filter }
filter:=ExtFml("Filter.Symbol","C:\URSC-ASX\Top-500.dat");

The code above will plot a "1" signal if it finds a match between the 
current chart symbol and the exact symbol found in the C:\URSC-ASX
\Top-500.dat file, and a "0" if it doesn't.  Adding this line of code 
as a filter to any system code, will force it to ignore any 
securities that are not part of the ASX's All Ords index.

Support:
jose@MetaStockTools.com

Additional services

mailto:jose@MetaStockTools.com


Personal trading system programming & testing, custom formula writing
for MetaStock and specialized data services are available for US
$60/hr.

Confidentiality and exclusivity is guaranteed.
http://www.MetaStockTools.com

I wish you all the best in your endeavor to develop
and trade your personal successful strategy.

Trade with the Strength.
jose  '-)

Disclaimer

For the purpose of the following disclaimer, the URSC plug-in kit 
will here on be referred to as the "software", and Jose Silva as its 
"author".

This software is sold with the understanding that no part of it may 
be copied and/or passed on to any third parties in any way or form.
You may make a copy of this software for backup purposes only. 
Copies made for any other purpose are prohibited and illegal.

The author will do his best to provide data needed by this software 
in a timely manner, but will not be held responsible by delays or 
interruptions beyond his control.

In no event shall the author be liable for any damage either direct 
or indirect, including, without limitation, damages for loss of 
business profits, business interruption, loss of business information 
or other losses arising out of the use of or inability to use this 
software.

The author is not a licensed investment advisor and so the 
information and results obtained by using this software is for 
educational purposes and of the nature of a general comment and 
neither purports nor intends to be, specific trading advice.
The information obtained from using this software should not be 
considered as an offer or enticement to buy, sell or trade and is 
given without regard to any particular person's investment 
objectives, financial situation and particular needs.
This software is not designed to replace your licensed financial 
consultant or your stockbroker. You should seek appropriate advice 
from your broker, or licensed investment advisor, before taking any 
action. 

The results obtained from using this software are not indicative of, 
and have no bearing on, any results, which may be attained in actual 
trading.
Results of past performance are no guarantee of future performance.
It should not be assumed that you would experience results comparable 
to that reflected by the results from this software. No assurance is 
given that you will not incur substantial losses, nor shall the 
author be held liable if losses are incurred.

http://www.MetaStockTools.com

